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						FOTOMONTAŻ
					
				

			

			
				
					
						znaki Zodiaku
					
					
						 
					
				

			

			
				
					
						o autorze
					
				

			

			
				
					
						– Ryby
					
				

				
					
						ćwiczenie z warstwami i maskami
					
				

			

			
				
					
						Tomasz Sarna
					
				

				
					
						Pracownik jednej z krakowskich agencji reklamowych 
					
				

				
					
						na stanowisku graik/operator DTP. Jako fotograf uży-
					
				

				
					
						wa Photoshopa przede wszystkim do retuszu zdjęć, ja-
					
				

				
					
						ko graik do fotomontaży i tworzenia ilustracji. W wolnych 
					
				

				
					
						chwilach zajmuje się rzeźbą. Portfolio: 
						www.sarna.pl
					
				

			

			
				
					
						Artykułem tym chciałbym zapoczątkować omówienie proscesu powstawania całej serii grafik, z których docelowo moż-
					
				

				
					
						na będzie złożyć kalendarz ze znakami zodiaku. Postaram się pokazać, że bardzo łatwo można, z pozornie różnych 
					
				

				
					
						zdjęć, stworzyć grafikę, która w żaden sposób nie odpowiada materiałom, z których powstała. Do wykonania poszcze-
					
				

				
					
						gólnych grafik wykorzystam zdjęcia, które już mam w swoim archiwum oraz takie, które powstaną specjalnie dla da-
					
				

				
					
						nego materiału. Obecnie dostęp do fotografii cyfrowej jest tak powszechny, że tworzenie tego rodzaju grafik jest łatwe 
					
				

				
					
						i jak zawsze, to nie narzędzia, ale warsztat tworzącego daje szerokie pole możliwości.
					
				

			

			
				
					
						głowa
					
				

				
					
						Cały projekt oparty jest na kształcie skrzydlicy. Korzystając z narzę-
					
				

				
					
						dzia
						 Shape
						 [
						P
						], rysujemy obrys głowy. Następnie przenosimy zdję-
					
				

				
					
						cie rdzy, które grupujemy z nowo powstałym kształtem. Używając bardzo 
					
				

				
					
						Miękkiego pędzla
						 [
						B
						], tworzymy cienie, 
						Tryb mieszania warstw z cienia-
					
				

				
					
						mi
						 zmieniamy na 
						Mnożenie
						 (
						Multiply
						). Używając 
						Ścieżek,
						 dodajemy cha-
					
				

				
					
						rakterystyczne paski, jakimi jest pokryta skrzydlica. Zmieniamy 
						Rodzaj 
					
				

				
					
						przenikania
						 na 
						Nakładka
						 (
						Overaly
						)
						 
						i dodajemy efekt 
						Blasku wewnętrzne-
					
				

				
					
						go
						 (
						Inner glow
						). Całość przenosimy do nowej grupy 
						Head
						.
					
				

			

			
				
					
						skrzela
					
				

				
					
						Obrysowujemy fragment helikoptera i przenosimy do nowej grupy
						 Bran-
					
				

				
					
						chia
						. Za pomocą 
						Swobodnego przekształcenia 
						dopasowujemy kształt, 
					
				

				
					
						włączając 
						Wypaczenie
						. Używając warstwy korekcyjnej 
						Balans kolorów
						, 
					
				

				
					
						zmieniamy barwę elementu. Przyciemniamy boki, używając warstwy 
						Krzy-
					
				

				
					
						we.
						 Na masce warstwy wybieramy 
						Pędzlem 
						[
						B
						] elementy, które powinny 
					
				

				
					
						być zaciemnione. Środek skrzeli kolorujemy za pomocą warstwy 
						Krzywe
						 na 
					
				

				
					
						zielono. Dodajemy cień, tworząc nową warstwę pod spodem oraz selekcję 
					
				

				
					
						z kształtu skrzeli, a następnie wypełniamy ją czarnym kolorem. Zmieniamy 
					
				

				
					
						tryb na 
						Mnożenie
						 oraz rozmywamy filtrem 
						Rozmycie gaussowskie
						.
					
				

			

			
				
					
						oko i pysk
					
				

				
					
						Korzystając z 
						Zaznaczania eliptycznego
						 (
						Eliptical Marquee Tool
						) [
						M
						], 
					
				

				
					
						wycinamy oko ze zdjęcia kota i przenosimy je do grupy 
						Head
						. Następ-
					
				

				
					
						nie, za pomocą miękkiego 
						Pędzla 
						[
						B
						], dodajemy cienie wokół oka oraz na 
					
				

				
					
						jego górnej i dolnej powiece. Ten zabieg spowodujebardziej realistyczny 
					
				

				
					
						efekt. Teraz rysujemy dwa kształty, które utworzą pysk ryby. Do każde-
					
				

				
					
						go grupujemy warstwę rdzy miękkim
						 Pędzlem
						 [
						B
						] rysujemy cienie, ana-
					
				

				
					
						logicznie jak w przypadku całej głowy. Na koniec całą maskę głównego 
					
				

				
					
						kształtu głowy obrysowujemy delikatnie bardzo poszarpanym pędzlem.
					
				

			

			
				
					
						lampa
					
				

				
					
						Wycinamy lampę ze zdjęcia i przenosimy do nowej grupy 
						lamp
						. Zmie-
					
				

				
					
						niamy rozmiar tak, aby pasował do całości [
						Ctrl
						]+[
						T
						]. Dodajemy war-
					
				

				
					
						stwę 
						Krzywe
						 (
						Curves
						) i zmieniamy całość kolorystyki na zielono. Następ-
					
				

				
					
						nie na masce malujemy pędzlem [
						B
						] w ten sposób, żeby zmienić kolor 
					
				

				
					
						tylko na części metalowej. Teraz, by odrobinę urozmaicić wygląd lampy, 
					
				

				
					
						dodajemy nową warstwę korekcyjną 
						Krzywe
						 (
						Curves
						) i tworzymy zie-
					
				

				
					
						lony odcień oraz podobnie, jak poprzednio – wybieramy na masce tyl-
					
				

				
					
						ko fragmenty lampy.
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						FOTOMONTAŻ
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						5
					
				

			

			
				
					
						skrzydła
					
				

				
					
						Kształty 
						skrzydeł 
						wykonujemy za pomocą ścieżek. Robimy to etapa-
					
				

				
					
						mi 
						–
						 po dwie lub trzy odnogi. Do każdego kształtu grupujemy warstwę 
					
				

				
					
						z rdzą, a brakujące wypełnienia klonujemy narzędziem 
						Stempel
						 [
						S
						]. Mięk-
					
				

				
					
						kim pędzlem rysujemy cienie na brzegach, a następnie cienie, które będą 
					
				

				
					
						się tworzyć na pogrubieniach skrzydeł. Cieniami operujemy w trybie 
						Mno-
					
				

				
					
						żenie
						. Dodajemy charakterystyczne paski, malując grubym pędzlem. 
						Tryb 
					
				

				
					
						mieszania
						 zmieniamy na 
						Nakładka 
						z
						 Kryciem
						 ok. 60-70%. Aby zwiększyć 
					
				

				
					
						widoczność uwypukleń, dodajemy jasne światła obok cieni za pomocą 
					
				

				
					
						miękkiego pędzla, zmieniamy tryb na 
						Nakładka
						. Czasem należy zdupliko-
					
				

				
					
						wać warstwę, a rodzaj trybu przełączyć na 
						Łagodne światło
						.
					
				

			

			
				
					
						dom – kolory
					
				

				
					
						Dodajemy warstwę korekcyjną 
						Curves
						, za pomocą której 
						podciąga-
					
				

				
					
						my
						 kontrast całości. Bardziej wyrazisty kolor zieleni trawy na dachu 
					
				

				
					
						uzyskamy za pomocą warstwy korekcyjnej 
						Kolor selektywny
						 (
						Selective 
					
				

				
					
						Colour
						). Podobnie, jak poprzednio, zmieniamy kolor ścian na intensyw-
					
				

				
					
						niejszy żółty, warstwą korekcyjną 
						Krzywe
						. Oczywiście wszystkie ko-
					
				

				
					
						rekty dokonywane za pomocą tych warstw są selektywne tzn., że prawie 
					
				

				
					
						każda z nich łaczy się z maską, określającą obszar działania zmian.
					
				

			

			
				
					
						0
						6
					
				

			

			
				
					
						skrzydła – wykończenie
					
				

				
					
						Na końcu 
						obcinamy 
						krawędzie malując po masce 
						Pędzlem 
						[
						B
						] o bar-
					
				

				
					
						dzo poszarpanej końcówce. Gdzieniegdzie możemy tym samym 
					
				

				
					
						pędzlem zrobić 
						przepalenia
						 w środku skrzydeł. W taki sam sposób two-
					
				

				
					
						rzymy pozostałe części skrzydeł. Aby całość pliku była przejrzysta, 
					
				

				
					
						a praca nie sprawiała trudności, poszczególne części wkładamy do od-
					
				

				
					
						dzielnych grup.
					
				

			

			
				
					
						ogon
					
				

				
					
						Ogon ryb tworzymy analogicznie jak skrzydła ryby, czyli wycina-
					
				

				
					
						my kształty ze zdjęcia z rdzą, a następnie podmalowujemy pędzlem 
					
				

				
					
						 grupujemy w osobny zestaw warstw.
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						7
					
				

			

			
				
					
						dom
					
				

				
					
						Kolejny etap to tworzenie tułowia ryby. Do tego celu wykorzystamy 
					
				

				
					
						zdjęcie przedstawiające dworek w Kozłówce. Dowolną techniką wy-
					
				

				
					
						cinamy budynek z tła. Następnie przenosimy do naszego dokumentu 
					
				

				
					
						i umieszczamy w nowej grupie 
						House
						. Podobnie, jak w przypadku two-
					
				

				
					
						rzenia skrzeli, modyfikujemy geometrię tak, by stworzyć ciekawą formę 
					
				

				
					
						grzbietu ryby. Potem wycinamy fragment trawy i korzystając z narzędzia 
					
				

				
					
						Stempel
						 (
						Clone Stamp Tool
						), klonujemy tak, aby pokryć całą powierzchnię 
					
				

				
					
						dachu. Warstwy z trawą grupujemy wraz z warstwami z domem. Usuwamy 
					
				

				
					
						wystające fragmenty, malując po maskach poszczególnych warstw trawy.
					
				

			

			
				
					
						końcowy dokument
					
				

				
					
						Zakończyliśmy właśnie pracę nad głównym motywem. Teraz wyko-
					
				

				
					
						namy pozostałą część grafiki. Aby praca nad całością była wygod-
					
				

				
					
						niejsza, po uprzednim zapisaniu pliku, łączymy wszystkie widoczne war-
					
				

				
					
						stwy do jednej 
						Warstwa>Złącz widoczne
						 (
						Layer>Merge Visible
						). Dzięki 
					
				

				
					
						takiemu rozwiązaniu możliwe będzie łatwiejsze poruszanie się po no-
					
				

				
					
						wym pliku. Tworzymy nowy dokument i przenosimy do niego naszą ry-
					
				

				
					
						bę, już jako jedną warstwę. 
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						znaki Zodiaku – Ryby
					
				

			

			
				
					
						ćwiczenie z warstwami i maskami
					
				

			

			
				
					
						tło
					
				

				
					
						Tłem do naszej ilustracji jest podrdzewiały fragment poszycia sta-
					
				

				
					
						rego parowozu. Niestety nie wystarczy tego zdjęcia na całość doku-
					
				

				
					
						mentu, dlatego korzystając z
						 
						narzędzia
						 Stempel (Clone Stamp Tool
						), klo-
					
				

				
					
						nujemy tak, aby wypełnić większą część projektu. Górną część możemy 
					
				

				
					
						skopiować gdzieś ze środka. Teraz zmieniamy kolorystykę, korzystając 
					
				

				
					
						z warstw korekcyjnych 
						Krzywe 
						(
						Curves
						).
					
				

			

			
				
					
						znak zodiaku
					
				

				
					
						Znak zodiaku wykonujemy korzystając z 
						Kształtów
						. Rysujemy grube 
					
				

				
					
						czarne koło. Rasteryzujemy warstwę 
						Wartwa>Razteryzuj>Wartswa
						. 
					
				

				
					
						Tworzymy prostokątną maskę tak, aby odciąć dokładnie połowę okręgu. Du-
					
				

				
					
						plikujemy tę połówkę i przesuwamy w lewo, by powstała kolejna selekcja z 
					
				

				
					
						nowej warstwy. Dzięki temu półokrąg będzie miał zwężone brzegi. Dodaje-
					
				

				
					
						my do warstwy maskę, na której bardzo postrzępionym pędzlem
						 szarpiemy
						 
					
				

				
					
						brzegi. Półokrąg duplikujemy [
						Ctrl
						]+[
						J
						], tworzymy lustrzane odbicie 
						Edytu-
					
				

				
					
						j>Przekształć>Obróć poziomo
						 i odsuwamy. Z tego samego elementu wyko-
					
				

				
					
						nujemy mniejszą pionową belkę. Wszystkie warstwy mają efekt cienia. Ca-
					
				

				
					
						łość umieszczamy w jednej grupie z trybem mieszania 
						Nakładka
						.
					
				

			

			
				
					
						główny motyw
					
				

				
					
						Teraz ustawiamy naszą rybę na miejscu, a następnie duplikuje-
					
				

				
					
						my warstwę [
						Ctrl
						]+[
						J
						] i zmniejszamy ją. Tworzymy lustrzane odbi-
					
				

				
					
						cie mniejszej ryby przy pomocy 
						Edytuj>Przekształć>Odwróć poziomo
						 
					
				

				
					
						(
						Edit>Transform>Flip Horizontal
						). Okazuje się, że w końcowym stanie do-
					
				

				
					
						kumentu należy zmienić jeszcze odrobinę kolorystykę oraz kontrast ryb. 
					
				

				
					
						Wykorzystamy do tego celu, podobnie jak poprzednio, warstwy korek-
					
				

				
					
						cyjne 
						Krzywe
						. Jeszcze dodatkowo obie warstwy z rybami zaopatrzymy 
					
				

				
					
						w cień, najprościej – używając styli warstwy 
						Cień
						 (
						Drop Shadow
						).
					
				

			

			
				
					
						teksty
					
				

				
					
						Oznaczenie dat tworzymy, używając fontów oraz zdjęć dat z kalenda-
					
				

				
					
						rza. Tryb mieszania warstwy zdjęcia z nr 21 zmieniamy na 
						Mnożenie
						 
					
				

				
					
						(
						Multiply
						), a widoczne brzegi wymazujemy na masce miękkim 
						Pędzlem 
					
				

				
					
						[
						B
						]. Podobnie robimy z nr 20, przy czym tym razem, zmieniamy rodzaj 
					
				

				
					
						przenikania na 
						Nakładka
						 (
						Overlay
						), a widoczne tło usuwamy za pomocą 
					
				

				
					
						funkcji 
						Mieszaj gdy
						 (
						Blend if
						). Wszystkie teksty piszemy czcionką 
						Adobe 
					
				

				
					
						Garamond
						. Na koniec dodajemy warstwę z drobnym tekstem, przenika-
					
				

				
					
						nie zmieniamy na 
						Nakładka 
						(
						Overlay
						), a niepotrzebne fragmenty usuwa-
					
				

				
					
						my na masce, korzystając z bardzo miękkiego pędzla.
					
				

			

			
				
					
						małe rybki – symbol
					
				

				
					
						Na dole grafiki dodajemy dwa małe kształty ryb. Wykonamy je z głów-
					
				

				
					
						nego elementu. Duplikujemy warstwę z mniejszą rybą, wyłączamy 
					
				

				
					
						efekt, a następne przytrzymując [
						Ctrl
						], tworzymy selekcję, którą wypeł-
					
				

				
					
						niamy czarnym kolorem. Przygotowany element duplikujemy [
						Ctrl
						]+[
						J
						]. 
					
				

				
					
						Tworzymy lustrzane odbicie używając 
						Edytuj>Przekształć>Obróć pozio-
					
				

				
					
						mo
						 (
						Edit>Transform>Flip Horizontal
						)
						.
						 Ustawiamy oba kształty naprze-
					
				

				
					
						ciwko, zmniejszamy do odpowiednich rozmiarów [
						Ctrl
						]+[
						T
						] i umieszcza-
					
				

				
					
						my na środku. Obie warstwy możemy sprasować do jednej [
						Ctrl
						]+[
						E
						].
					
				

			

			
				
					
						zakończenie
					
				

				
					
						Na koniec dorysowujemy czarną ramkę. Wokół całej grafiki two-
					
				

				
					
						rzymy prostokątną selekcję [
						M
						], następnie modyfikujemy ją 
					
				

				
					
						Zaznacz>Zmień>Brzeg
						 (
						Select>Modify>Border
						) i wielkość ustawia-
					
				

				
					
						my na ok. 200 px. Teraz rozmywamy, korzystając z 
						Zaznacz>Wtapianie
						 
					
				

				
					
						(
						Select>Feather
						)
						,
						 a wartość ustawiamy na 250px. Selekcja ta posłuży ja-
					
				

				
					
						ko maska do ostatniej warstwy korekcyjnej 
						Curves
						, którą zaciemnimy 
					
				

				
					
						brzegi grafiki. 
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